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Tonight

e Learn to create a Web page
e Think about what the Web “Is”

« Talk conceptually about databases



Internet = Web

* Internet: collection of global networks
« \Web: way of managing information exchange

* There are many other uses for the Internet
— File transfer (FTP)
— Email (SMTP, POP, IMAP)
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Web Standards

e« HTML
— How to write and interpret the information

e URL
— Where to find i1t

e HTTP
— How to get it



Uniform Resource Locator (URL)
« Uniquely identify Web pages

Domain name File name

A A
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http://www.glue.umd.edu:80/~oard/teaching.html
Protocol Port || Path




HyperText Markup Language (HTML)

o Simple document structure language for Web

« Advantages
— Adapts easily to different display capabilities
— Widely available display software (browsers)

e Disadvantages
— Does not directly control layout



“Hello World™ HTML s e nease

|
' <title>Hello World!<ftitle> l
' </head> :

This is the actual content of the HTML document



Hands On:
Learning HTML From Examples

« Use Internet Explorer to find a page you like
— http://terpconnect.umd.edu/~oard

e On the “View” menu select “Source” (in IE)
— Opens a notepad window with the source

e Compare HTML source with the Web page
— Observe how each effect 1s achieved



Hands On: “Adopt” a Web Page

Modify the HTML source using notepad
— For example, change the page to yours

Save the HTML source somewhere
— In the “File” menu, select “Save As”
— Put the name in guotes (e.g., “test.ntml’)

FTP it to your ../pub directory on terpconnect

View it
— http://terpconnect.umd.edu/~(yourlogin)/test.html



TIps

Edit files on your own machine
— Upload when you’re happy

Save early, save often!
Reload browser to see changes

File naming
— Don’t use spaces
— Punctuation matters




What’s a Document?

Content

Structure

— Logical, Physical
Appearance

— Cascading Style Sheets

Behavior
— JavaScript



HTML Document Structure

e “Tags” mark structure
— <html>a document</html|>
— <ol>an ordered list</ol>
— <i>something In italics</i>
e Tag name In angle brackets <>
— Not case sensitive (unlike XML)
e Open/Close pairs
— Close tag 1s sometimes optional (unlike XML)




Logical Structure Tags

e Head
— Title

* Body
— Headers: <h1> <h2> <h3> <h4> <h5>
— Lists: <ol>, <ul> (can be nested)
— Paragraphs:<p>
— Definitions: <dt><dd>
— Tables: <table> <tr> <td> </td> </tr> </table>
— Role: <cite>, <address>, <strong>, ...



Physical Structure Tags

Bold: <b></b>

Italics: <I></1>

Typeface: <font face="Arial”’></font>
Size: <font size="“+1"></font>

Color: <font color=*990000”></font>



(Hyper)Links

index.html

<html>

<head>

<title>Hello World!</title>

</head>

<body>

<p>Hello world! This is my first webpage!</p>

<p>Click <a href="test.html">here</a> for another page.</p>

</body>
</html> \

test.html \,

<html|>

<head>

<title>Another page</title>
</head>

<body>

<p>This is another page.</p>
</body>

</html|>




Hypertext “Anchors”

Internal anchors: somewhere on the same page

— <a href="#students”> Students</a>
e Links to: <a name=“students”>Student Information</a>

External anchors: to another page

— <a href="http://ischool.umd.edu”>iSchool</a>
— <a href="http://terpconnect.umd.edu/~oard/research.ntml#email”>email papers</a>

URL may be complete, or relative to current page
— <a href="video/week2.rm”>2</a>

File name (in URL) Is case sensitive (on Unix servers)
— Protocol and domain name are not case sensitive



Images

e <img src="URL”’> or <img src="“path/file’”>
— <img src="http://www.clis.umd.edu/IMAGES/head.gif”>
— SRC: can be url or path/file
— ALT: atext string
— ALIGN: position of the image
— WIDTH and HEIGHT: size of the image

e Can use as anchor:
- <a href=URL><img src=URL2></a>

e Example:
— http://www.umiacs.umd.edu/~dagingd/Image-Alignment.html



Tables

<table>
<tr>td> - <[td><td> - <[td><td> ___ - </td>
r eenie mennie miney
<tr>ktd> mo </td><td> CatCh </td><td> a tiger</td>
<tr>kKtd> by </td><td> the </td><td> toe </td>

</table>

<[tr>

<[tr>

<[tr>



Table Example

<table align="center”>
<caption align="right”>The caption</caption>
<tralign="“"LEFT”>
<th> Headerl </th>
<th> Header2</th>

</tr>

<tr><td>first row, first item </td>

<to
< tr><ta

<tQ
<[table>

>first row, second item</td></tr>
>second row, first item</td>
>second row, second item</td></tr>



XHTML: Cleaning up HTML

<?xml version="1.0" encoding="1s0-8859-1"?>
<html xmlns="http://www.w3.0org/TR/xhtmI1" >
<head>
<title> Title of text XHTML Document </title>
</head>
<body>
<div class="myDiv">
<h1> Heading of Page </h1>
<p> here is a paragraph of text. | will include inside this paragraph
a bunch of wonky text so that it looks fancy. </p>
<p>Here is another paragraph with <em>inline emphasized</em>
text, and <b> absolutely no</b> sense of humor. </p>
<p>And another paragraph, this one with an <img src="image.gif"
alt="waste of time" /> image, and a <br /> line break. </p>
</div>
</body></html|>



Defining Blocks of Text

o <div> ... </div>

— Named region

— Implies a paragraph break,

— Can include multiple paragraphs
* <p> ... </p>

— Individual paragraph
e <span> ... <span>

— Any region

— Does not create a paragraph break



Cascading Style Sheets (CSS)

e Separate content and structure from appearance

e Rules “cascade” from broad to narrow:
— Browser default
— External style sheet
— Internal style sheet
— Inline style



Basics of CSS

 Basic syntax:
selector {property: value}

f

HTML tag you want to modify...
The property you want to change...

The value you want the property to take

e Example:

p { text-align: center;
color: black;
font-family: arial }

Causes

— Font to be center-aligned
— Font to be Arial and black



Different Ways of Using CSS

 Inline style:

— Causes only this tag to have the desired
properties

<p style="font-family:arial; color:blue*>...</p>

* Internal stylesheet:
— Causes all tags to have the desired properties

<head>...
<style type="text/css" >
p { font-family:arial; color:blue}
</style>
</head>
<body>
<p>...</p>



Customizing Classes

 Ability to define customized styles for
standard HTML tags:

<head>...

<style type="text/css">
p.stylel { font-family:arial; color:blue}
p.style2 { font-family:serif; color:red}

</style>

</head>

<body>

<p class="“stylel“>...</p>

<p class="“style2“>...</p>



External Style Sheets

 Store formatting metadata in a separate file
mystyle.css

p.stylel { font-family:arial; color:blue}
p.style2 { font-family:serif; color:red}

<head>...
<link rel="stylesheet™ href="mystyle.css" type="text/css" />
</head>

<body>

<p class="stylel">...</p>

<p class="style2">...</p>




Programming for the Web

 JavaScript [Client-side]
— Server embeds a program in HTML
— Browser runs the program when it gets to it

 PHP “Common Gateway Interface” [Server-side]
— HTML form sends field values to the server
— Server passes field values to a program
— Program generates a Web page as a response

e Ajax
— Server sends browser a generic program to run
— Browser and server programs exchange XML-encoded data



JavaScript

<HTML>
<HEAD>
<TITLE>My first script</TITLE>
</HEAD>
<BODY BGCOLOR=WHITE>
<H1>
<SCRIPT LANGUAGE=JAVASCRIPT TYPE="TEXT/JAVASCRIPT">
document.write(""Hello, world!")
</SCRIPT>
</H1>
</BODY></HTML>



HTML Editors

e Several are available

— Dreamweaver
— Microsoft Word (File->"Edit with MS Word” in |IE)

e You may still need to edit the HTML file
— Some editors use browser-specific features
— Some HTML features may be unavailable
— File names may be butchered when you upload

e Verbose HTML can make hand-editing difficult



What Is the Web?

Protocols
— HTTP, HTML, or URL?

Perspective
— Content or behavior?

Content
— Static, dynamic or streaming?

Access
— Public, protected, or internal?



Why Is there a Web?

Affordable storage
— 300,000 words/$ in 1995

Adequate backbone capacity
— 25,000 simultaneous transfers in 1995

Adequate “last mile” bandwidth
— 1 second/screen in 1995

Display capability

— 10% of US population in 1995

Effective search capabilities
— Lycos and Yahoo were started in 1995



Global Internet Users

[ Russian



Most Widely-Spoken Languages

B Secondary
800 - B Primary

Number of Speakers (millions)
a1
o
o

Source: Ethnologue (SIL), 1999



Global Trade

Leading economies of merchandise trade, 2009
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Databases

e Database
— Collection of data, organized to support access
— Models some aspects of reality

« DataBase Management System (DBMS)
— Software to create and access databases

* Relational Algebra
— Special-purpose programming language



Structured Information

Field An “atomic” unit of data

— number, string, true/false, ...

Record A collection of related fields
Table A collection of related records

— Each record i1s one row In the table
— Each field is one column in the table

Primary Key The field that identifies a record
— Values of a primary key must be unigue

Database A collection of tables



A Simple Example

Ty

orimary key

Membership Plans file
Membership Code | Membership Name | Monthly Fee |

FITMESS CENTER DATABASE L Late Shift $20.25
f Matinea $25.75
P Frime Timea $45.50 remrdsl
R Round the Clock $55.50
W Weekender $39.50 A/

Characteristics of Membership Code field

Field Size 1

Faormat

Inpaust Mask. maximum
Membership Code characters in

Caption

Default Value Membership
Walidation Fude "L O "M O P Or "R Or "W" Code field
Yalidation Text Please enter valid membership code,

Required s

Allow Zero Length Mo

Indexed Yes (Mo Duplicates)




Registrar Example

e \Which students are in which courses?

* \What do we need to know about the students?
— first name, last name, email, department

* \What do we need to know about the courses?
— course ID, description, enrolled students, grades



A “Flat File” Solution

Student ID Last Name  First Name Department ICDepartmen:Course ID Course description  Grades email

1 Arows John EE EE losc690  Information Technology 90  jarrows@wam

1 Anows John EE Elec Engin ee750  Communication 95 ja_2002@yahoo
2 Peters Kathy HIST HIST losc690 Informatino Technology 95  kpeters2@wam
2 Peters Kathy HIST history hist405  American History 80  kpeters2@wma
3 Smith Chris HIST history ~ hist405  American History 90  smith2002@glue
4 Smith John CLIS Info Sci Ibsc690  Information Technology 98 js03@wam

Discussion Topic
Why Is this a bad approach?



Goals of “Normalization”

Save space
— Save each fact only once

More rapid updates
— Every fact only needs to be updated once

More rapid search
— Finding something once is good enough

Avoid inconsistency
— Changing data once changes it everywhere



Relational Algebra

Tables represent “relations”
— Course, course description
— Name, email address, department

Named fields represent “attributes”

Each row In the table is called a “tuple”
— The order of the rows Is not important

Queries specify desired conditions
— The DBMS then finds data that satisfies them



A Normalized Relational Database

Student Table

Student ID Last Name First Name |DepartmentID email

1 Arrows John EE jarrows @wam

2 Peters Kathy HIST kpeters2@wam

3 Smith Chris HIST smith2002@qglue

4/ Smith John CLIS js03@wam
Department Table Course Table
Department ID Department Course ID Course Description
EE Electronic Engineering Ibsc690 Information Technology
HIST History ee750 Communication
CLIS Information Stuides hist405 American History

Enrollment Table

Student ID Course ID Grades
1 Ibsc690 90
1 ee750 95
2 Ibsc690 95
2 hist405 80
3 hist405 90

4 |bsc690 98



Approaches to Normalization

e For simple problems (like the homework)

— Start with “binary relationships”
e Pairs of fields that are related

— Group together wherever possible
— Add keys where necessary

e For more complicated problems
— Entity relationship modeling (LBSC 670)



Example of Join

Student Table Department Table
Student ID Last Name First Name Department ID  email Department ID Department
1 Arrows John EE jarrows@wam £E Electronic Engineering
2 Peters Kathy HIST kpeters2@wam :
3 Smith Chris HIST smith2002@alue HIST History
4 Smith John CLIS js03@wam CLIS Information Stuides
“Joined” Table
Student ID Last Name  First Name Department ICDepartment emall
1 Arows John EE Electronic Engineering  jarrows@wam
2 Peters Kathy HIST History kpeters2@wam
3 Smith Chris HIST History smith2002@glue
4 Smith John CLIS Information Stuides S03@wam




Problems with Join

« Data modeling for join is complex
— Useful to start with E-R modeling

e JoIn are expensive to compute
— Both in time and storage space

e But it Is joins that make databases relational
— Projection and restriction also used in flat files



Some Lingo

* “Primary Key” uniquely identifies a record
— e.g. student ID in the student table

e “Compound” primary key
— Synthesize a primary key with a combination of fields
— e.g., Student ID + Course ID in the enrollment table

e “Foreign Key” Is primary key in the other table
— Note: it need not be unique in this table



Project

New Table
Student ID Last Name  First Name Department ICDepartment email
1 Amows John EE Electronic Engineering  jarrows @wam
2 Peters Kathy HIST History kpeters2@wam
3 Smith Chris HIST History smith2002@qlue
4 Smith John CLIS Information Stuides S03@wam

l SELECT Student 1D, Department

Student ID Department
1 Electronic Engineering
2 History
3 History
4 Information Stuides



Restrict

New Table

Student ID Last Name  First Name Department ICDepartment email
1 Amows John EE Electronic Engineering  jarrows @wam
2 Peters Kathy HIST History kpeters2@wam
3 Smith Chris HIST History smith2002@qlue
4 Smith John CLIS Information Stuides S03@wam

WHERE Department 1D = "HIST”

Student ID Last Name First Name Department ICDepartment email

2 Peters Kathy ~ HIST History kpeters2@wam

3 Smith Chris HIST History smith2002@glue




Entity-Relationship Diagrams

 Graphical visualization of the data model
 Entities are captured in boxes

* Relationships are captured using arrows



Registrar ER Diagram

Student
Enrollment Student ID
Student First name
has
Course » Last name
Grade Department
E-mail
has associated with
course Department
Course ID Department ID

Course Name

Department Name




Getting Started with E-R Modeling

* \What questions must you answer?

e \What data Is needed to generate the answers?

— Entities
o Attributes of those entities

— Relationships
 Nature of those relationships

 How will the user interact with the system?
— Relating the question to the available data
— Expressing the answer in a useful form



“Project Team” E-R Example

student

human

client

manage-role
1
v 1 eam
1
M
implement-role| <-Creates
1
1 needs MY broject

/@\

php-project

ajax-project




Components of E-R Diagrams

* Entities
— Types
 Subtypes (disjoint / overlapping)

— Attributes
e Mandatory / optional

— ldentifier
* Relationships
— Cardinality

— EXxistence
— Degree



Types of Relationships




Making Tables from E-R Diagrams

Pick a primary key for each entity

Build the tables

— One per entity

— Plus one per M:M relationship

— Choose terse but memorable table and field names
Check for parsimonious representation

— Relational “normalization”

— Redundant storage of computable values

Implement using a DBMS



Normalization

1NF: Single-valued indivisible (atomic) attributes
— Split “Doug Oard” to two attributes as (“Doug”, “Oard”)
— Model M:M implement-role relationship with a table

2NF: Attributes depend on complete primary key
— (id, impl-role, name)->(id, name)+(id, impl-role)

3NF: Attributes depend directly on primary key
— (id, addr, city, state, zip)->(id, addr, zip)+(zip, city, state)

ANF: Divide independent M:M tables
— (id, role, courses) -> (id, role) + (id, courses)

5NF: Don’t enumerate derivable combinations



Normalized Table Structure

Persons: id, fname, Iname, userid, password
Contacts: Id, ctype, cstring

Ctlabels: ctype, string

Students: 1d, team, mrole

Iroles: 1d, Irole

Rlabels: role, string

Projects: team, client, pstring




A More Complex ER Diagram

Cadastral Standard ERD
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http://www.fairview-industries.com/standardmodule/cad-erd.htm
http://www.fairview-industries.com/standardmodule/cad-erd.htm
http://www.fairview-industries.com/standardmodule/cad-erd.htm
http://www.fairview-industries.com/standardmodule/cad-erd.htm
http://www.fairview-industries.com/standardmodule/cad-erd.htm

Key ldeas

« Databases are a good choice when you have
— Lots of data
— A problem that contains inherent relationships

* Design before you implement
— This Is just another type of programming
— The mythical person-month applies!

e Join Is the most important concept
— Project and restrict just remove undesired stuff



Before You Go

On a sheet of paper, answer the following
(ungraded) question (no names, please):

What was the muddiest point In
today’s class?
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